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The Inbox Ninjas: Helping You 
Chop Through Your E-Mail Inbox 

 
1. Problems With Email: 

A. Too many Interruptions:   Most lawyers receive 100+ emails per day which 
means that we're receiving an email every 4.8 minutes in an 8 hour day.  The 
impact of this: 28% of a day spent dealing with unnecessary interruptions1. 

B. Email Storage:    What do we do with all of this email?  There are several 
problems related to this: 

i. Disorganization: Most people have hundreds or thousands of unrelated 
messages in their inboxes.  This is equivalent to taking all of the paper out 
of your files and throwing it on the floor of the file room.  The point is, if 
it's not organized, then it's mostly useless. 

ii. Storage Space Limitations: You may have been scolded by your IT folks 
about this.  If you're using Microsoft Exchange on your server, then it can 
get overloaded with the quantity of emails and attachments you keep in 
your inbox and Outlook folder structures.  If you don't have Exchange, 
then all of those emails (and contacts, and appointments and tasks) are 
stored in a PST file (Outlook database) on your hard drive or the server.  
The bigger that database, the slower your computer will run.  Of course, 
the database can also over-run your storage capacity. 

iii. No One Else Can See Your Email But You: In most cases, if you have 
an important client communication in Outlook, no one else in your office 
can see it.  In many cases, lawyers want to share this information, but don't 
know how to do it. 

iv. Difficulties Searching: Many people complain that it's nearly impossible 
to efficiently search old emails for a particular conversation.  What can 
you do to make this task easier? 

v. Printing Email Just Makes Paper Files More Unwieldy:  How can you 
share case-related email with others in the firm aside from printing it and 
putting it in the paper file (which is utterly useless). 

C. Too Much Legitimate Email To Deal With Effectively: Many people simply 
receive more email than they can read and keep up with.  How do you respond, 
take action, sort, store and track all of this email? 

                                                 
1 See Lost in E-Mail, Tech Firms Face Self-Made Beast, The New York Times, June 14, 2008, 
http://tinyurl.com/y9vxuvk. 
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D. No Expectation of Privacy:  The old saying goes:  You should never send an 
email that would embarrass you were it to appear on the front page of tomorrow's 
paper.  Is there anything you can do to create an expectation of privacy? 

E. Too Much Spam Getting Through:  There are lots of ways to avoid SPAM, and 
yet it still manages to get into our mailboxes.  What can you do about it? 

F. You're Not Using Outlook Effectively:   Although millions of people use 
Outlook, most do not use all of its functionality to their advantage.  In this 
seminar, we'll give you some great tips for making better use of Outlook. 

2. Organize Outlook: 

A. How To Set Up A New Email Folder:  To Setup a new Subfolder in your Inbox, 
right-click the Inbox (or your mailbox)  New Folder.  Give it a name and make 
sure it will contain Mail and Post Items.  Then click OK. 

 

B. Two Folders Everyone Should Have:  

Outlook tools such as Rules and Alerts and add-ons may help you manage your 
inbox, but they need to be coupled with the right folders in order to be truly 
effective.  These two folders can bring you a long way in helping you sort 
automatically a great amount of your emails: 

i. “Non-urgent”:  Where non urgent communications such as general 
announcements inside your organization or newsletters should be 
automatically sorted in this folder by an Outlook rule. 

ii. “Buffer”:  A buffer zone between your inbox and the trash, to keep your 
inbox clean from emails that you know you will eventually delete, but that 
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you’re scared of sending to trash too soon.  This is where you would sort 
the conversation-like threads that don’t need to be archived in the long 
term.  This folder is especially useful when using these Outlook add-ons 
that can sort both outgoing and incoming mail when replying. 

3. Outlook Rules and Alerts: 

A. Outlook Rules:  Rules allow you to auto-sort incoming email (among other 
things).  Here's how you set one up: 

i. Click the Tools menu  Rules and Alerts. 

ii. Click the New Rule button. 

iii. Select Start from blank rule if you’re using Outlook 2003 or prior.  If 
you’re using Outlook 2007, then choose the appropriate item from the list 
below: 

 

iv. Follow the steps for selecting the Condition, Action, Exceptions, then give 
it a name and make sure the rule is turned on! 

v. Rules on the fly: You can also create a rule by right-clicking on an email 
and selecting Create rule.  For example, if an email you just received from 
a newsletter has just buried an important email out of your sight, you may 
instantly  create a rule that will, in the future, automatically redirect an 
email from this newsletter in your “Non Urgent” folder. 
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B. Rule To Delay Sent Mail By One Minute (in case you change your mind): 

i. In Outlook, click on the Tools menu  Rules and Alerts  New Rule 
button. 

ii. Under "Start from a blank rule," choose "check messages after sending." 

iii. On the next screen ("which conditions do you want to check"), don't check 
anything (you want this rule to apply to every email you send) and click 
the Next button at the bottom.  You'll see the following dialog (click Yes): 

 

iv. In the next screen, check "defer delivery by a number of minutes," and 
then click the hyperlink for "a number of" at the bottom of the screen and 
enter the number of minutes you want to delay your email. 

 



  
The Inbox Ninjas: Helping You 
Chop Through Your E-Mail Inbox 
March 26, 2010 

 Page 6 of 24 

 

v. Click Next and add any exceptions (for people you don't want to delay 
email to). 

vi. Click Next, name your rule Delay and click Finish. 

C. Rule To Keep Track of Delegated Email:  Many people forward email to others 
to deal with but have a difficult time remembering what they delegated for follow 
up purposes.  Here's a rule that will help. 

i. First, create a folder in Outlook called Delegated Email. 

ii. In Outlook, click on the Tools menu  Rules and Alerts  New Rule 
button. 

iii. Under "start from a blank rule," choose "check messages when they 
arrive" and click Next at the bottom of the dialog. 

iv. Under "check which conditions do you want to check," check BOTH 
"from people or distribution list" and "where my name is in the CC box."  
At the bottom of the dialog, click the hyperlink for "people or distribution 
list" and add your email address.  We're basically creating a rule that will 
look for emails from you and copied to you.  Click Next. 

v. Under "what do you want to do with the message," choose "move it to the 
specified folder."  Make the specified folder your Delegated Mail folder.  
Click Next and add any exceptions.  Click Next, name it and click Finish. 

4. Outlook Add-On Programs To Help Sort & Store Email:  These add-ons bring great 
features to Outlook and they can all be tried for free.  With Simplyfile for example, a 
window pops up every time you send an email, asking you where to sort the email you’re 
sending.  It even offers you suggestions about the folder that is the most likely to be the 
one where you want to file the email you’re sending (and most of the time, the first 
suggestion is correct!).  If you respond to an email, it can also send the email you are 
responding to automatically in the same folder.   

Example:  Your friend sends you an email about a recent free agent signing of your 
hometown baseball team.  You respond and tell Simplyfile you want to sort your 
outgoing email in your “Buffer” folder, your friend’s email (that clearly was not worthy of 
a spot in your inbox anyways) will also be sorted in your “Buffer” folder.  Later in the 
day, you tell your friend how bad of a signing this was…  and that he could have sent 
you this information through instant messaging instead of crowding your inbox with an 
info that you were bound to learn by yourself anyways. 

A. SpeedFiler by Claritude - see www.claritude.com.  This program will auto file 
incoming and outgoing messages and has sophisticated search functions.  It has a 
30 day free trial, and it's $25/$40 to buy. 
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B. Xobni -  see www.xobni.com - find people, email & attachments instantly; it's 
FREE. 

C. QuickFile4Outlook - Lawyers Edition: See www.outlook4lawyers.com - Full 
filing system, 30 day free trial, $97 to buy. 

D. Simplyfile - see www.techhit.com/SimplyFile - 30 day free trial, $40 to buy 

5. Best Search Utility:  Copernic Desktop Search Professional - www.copernic.com - 
$50.  Search all email in all Outlook folders (including archived) AND all of the 
attachments to every email by content in seconds.  Get a 20% discount by entering the 
coupon code CAPHMUConsul during check-out. 

6. Archiving Old Outlook Email:  Many Outlook users end up with an enormous 
accumulation of email in their Sent Mail and Deleted Mail folders.  Furthermore, some 
mail is sorted into subfolders and forgotten about.  All of this will start to bog down 
servers and PCs as those databases of emails get larger and larger.  Thankfully, Outlook 
has an excellent way to dealing with this problem - AutoArchive.  In a nutshell, 
AutoArchive will allow you to a) permanently delete expired items; b) delete or c) 
archive old items to an archive file (archived database).  Conveniently, the first time 
AutoArchive runs, it creates the archive database for you.  It is stored on the C:\ by 
default so you'll either want to move it to a server folder or back it up directly from your 
C:\.  Once it has established itself, you'll see the Archive folder in your Outlook Folder 
List.  There are two sets of AutoArchive settings: global settings and per-folder settings. 

A. Turn AutoArchive On or Off.  Click the Tools menu  Options  Other tab  
click the AutoArchive button.  At the top of the following dialog, you'll see "Run 
AutoArchive every __ days."  If you uncheck that box, it will not run.  As you can 
see from the following screen shot, you have many options for this: 
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Note that these are your default (global) AutoArchive settings. 

B. Control the Archive Settings of a Specific Folder: You can control what any 
particular folder does in Outlook by following these steps:  Right-click the folder 
 choose Properties  click the AutoArchive tab  Make your changes and 
click OK. 

7. Saving Email Messages Outside of Outlook: When an email message is in your 
Outlook inbox, it's just a record in a database and not a discreet document like a Word 
file.  That fact is a big part of the problem associated with organizing and storing them.  
Email related to a particular matter is stored in one place; and word processor files related 
to that matter are stored somewhere else.  However, you can create documents out of 
those emails and those documents can be stored with every other document related to a 
particular matter or issue. 

A. Saving Email As A Document: The classic problem that law firms have if they 
do not own a document management system is saving and finding matter-specific 
email.  Why?  Because people (1) keep them in their individual inboxes, or (2) 
save them in subfolders within their own inbox (which no one else has access to), 
or (3) delete the email altogether.  Email is valuable correspondence that in most 
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circumstances should be saved.  However, in a law firm or legal department, it 
should not be saved within one's own individual inbox.   

As it turns out, you can save email much like you save a Microsoft Word 
document clicking the File menu  Save As (Outlook 2003) or Office Button  
Save As (Outlook 2007).  I recommend that you change the Save as type to 
Outlook Message Format (*.msg).  By default it will be HTML. 

 

You can also save email as Text Only although you'll lose any formatting that 
was in the email.  Saving as an MSG file will retain the original formatting, look 
and feel of the email.   

B. Saving Email By Dragging Into a Windows Explorer Folder: You can clean 
out your inbox or subfolders under your inbox by cascading the windows and 
simply dragging and dropping all of them into the desired folder.  This will COPY 
the emails over into that folder, saving them automatically as MSG (native 
Outlook Message Format) files, which preserves the metadata and all attachments. 

C. Saving Email With Document Management Programs (DMS): While 
document management programs (Worldox, Autonomy Worksite, NetDocuments, 
etc.) were originally thought of as only word processing document repositories, 
that is no longer true.  They can now hold just about any type of computer file 
(word processor, PDF, TIF, email, JPG, etc.).   

D. Worldox Example: Using Worldox as an example, it provides 3 different ways to 
save emails (see below).  Once profiled and saved, the emails are stored within 
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the client/matter structure and easily searchable and accessible by anyone who 
uses the document management system (Worldox, in this case)..  It's also 
important to note that you can save them one-at-a-time or large quantities of them 
all at once. 

i. Save Email From Within Outlook - Drag and Drop: Saving to Worldox 
from within Outlook – Drag and Drop on the Worldox "folder" for a 
particular matter. 

 

ii. Save Email From Within Worldox - Copy or Move Buttons: The 
Worldox/Outlook integration also provides Copy To Worldox or Move 
to Worldox buttons (located in the toolbar region of Outlook).  Simply 
select the email(s) you want to save into the system, then click the 
appropriate button shown below. 

 

iii. Save Email From Within Worldox:  Saving email from the Worldox 
Email Tab which allows you to see your Outlook inbox from within 
Worldox. 
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E. Saving Email Using a Case/Practice Management Program: This would 
include programs like Amicus Attorney, TimeMatters, Practice Master, etc.  If 
you have a case management program with Outlook integration, you can 
streamline the saving of email by saving them directly into the matter within the 
case management program.  You can also auto-associate emails by setting up 
rules within the practice management program based on the sender. 

F. Saving Email as PDF Files:  If you have Adobe Acrobat version 7, 8 or 9, it 
installs a few buttons and one additional menu in Microsoft Outlook.  For those 
that wish they had a good way to archive and store emails and attachments, this 
integration can be a life-saver. 

 

i. Acrobat - Creating PDFs from Individual Emails or Entire Folders: 
Simply select individual emails (Ctrl + left click) or select entire folders; 
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then click the Adobe PDF menu  Convert Selected Messages  Create 
New PDF.  This will create a single PDF which contains all of the emails 
you’ve selected and all of the attachments thereto.   

ii. Acrobat - Adding Subsequent Emails to Existing PDFs: If you receive 
additional emails which need to be added to an existing PDF archive, 
simply choose Convert Selected Messages  Append to Existing Adobe 
PDF. 

iii. Acrobat - Automatic Archival: As you can see from the screen shot, you 
can also setup folders to automatically archive themselves.  This would be 
particularly useful if you have setup Outlook rules to automatically sort 
your email into specific folders and then use Acrobat to automatically 
archive it. 

 

iv. Saving PDFs Without Acrobat: If you don't have Acrobat, you can still 
save email as PDFs.  You're not going to get the slick Outlook integration 
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buttons and menus, but you can certainly open an email and create a PDF 
from it using any PDF creator program, several of which are free.  For 
example, I would recommend either of the following free PDF makers. 

a. PDFCreator - free - http://sourceforge.net/projects/pdfcreator 

b. PDF995 - free - www.pdf995.com 

c. CutePDF - www.cutepdf.com 

8. Email Storage Tips: 

A. Store Email With Other Related Files: Store the email in the same location as 
other electronic files related to any particular matter.  Any system that requires 
you to save email separately from other electronic files related to a matter is 
inadequate. 

B. Delete or Archive Email Once Stored: After an email is stored into a folder or a 
document management system, delete or archive it.  Keep Outlook as clean as 
possible. 

C. Always Separately Save Attached Documents unless using DMS: Outlook is 
NOT a document management system and should not be used as a document 
repository.  Documents attached to Outlook emails are actually stored in a 
temporary folder structure that is incredibly convoluted and is normally hidden.  
For example, the attachment to an email I just opened is stored in my hard drive 
under this folder: 

C:\Users\barron\AppData\Local\Microsoft\Windows\Temporary Internet 
Files\Content.Outlook\O0T0A5E5 

For the record, that's 8 folders deep and the structure from \Temporary Internet 
Files down is not even visible in Windows Explorer.  The point is, it is incredibly 
easy to lose attached documents that aren't saved separately (unless you have a 
document management system that saves attachments at the same time the 
email itself is saved). 

D. Stop Printing Email: If you've saved email digitally, then they're easily 
searchable and printing them to throw in paper files only makes your paper files 
fatter, harder to manage and harder to search. 

E. Change The Subject Line on Received Email:  When an email is open, you can 
type a new subject line which helps you sort email in your folders.  For example, I 
might change the subject line “Re: Re: Re: Getting Back To You” to “Jones v. 
Jones Divorce”. 

9. Dealing with Email Overload: 
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A. Turn Off Outlook's Notifications About Email:  You see that little envelope in 
the bottom, right corner of your screen and you can almost hear it saying, "read 
me!"  The constant notifications of new email are one of the primary distractions 
for most people.  So turn them off!  It's amazing how more focused you can be 
when your computer isn't announcing incoming email every few minutes (or 
seconds).  Honestly, this is the best thing I've ever done regarding email.  To do 
this in Outlook 2007,. click the Tools menu  Options  Preferences tab  E-
mail Options button  Advanced E-mail Options button and uncheck the boxes 
you find there. 

 

B. Deal With Email At Set Times Of The Day:  The first problem that we want to 
deal with is the reduction of interruptions so one can be more focused and 
productive.  After all, how on earth can anyone get anything done with an 
interruption every 2-3 minutes?   

Ask yourself the following question:  10 years ago, would you have let someone 
walk in your office every 2-3 minutes offering to sell you a sexual enhancement 
product… or asking you for a favor? 



  
The Inbox Ninjas: Helping You 
Chop Through Your E-Mail Inbox 
March 26, 2010 

 Page 15 of 24 

 

Of course you wouldn't!  So, why do you let it happen now with your email?  
Why do you drop everything that you are doing to read and/or respond to that 
email that just arrived?!  You have invested thousands of dollars in this 
wonderful technology that is supposed to make you more efficient, but instead it 
has created an interruption hotline going straight to your brain. 

Some time management experts suggest checking email 2 times a day.  While 
this may sound like a good plan, it is probably unrealistic.  When email was just 
becoming popular, there wasn't an expectation of that email would be dealt with 
immediately, so 2 times per day was probably okay.  However, in today's age 
that has changed to some degree.  Entire companies communicate via email … 
it’s a way of life and the way everyone communicates.  Checking email twice a 
day isn't enough.  I think 3-5 times a day is more realistic … more satisfying to 
senders … and just as important, will make it easier for you to prevent your 
inbox from growing out of control. 

A good way to handle this is deal with email at the same time every day.  For 
example, you could following this schedule and limit yourself to 10-15 
minutes. 

1 – Upon arrival at the office:  8:00 am 

2 – Mid morning:  10:30 am 

3 – After lunch:  12:30 pm 

4 – Afternoon:  3:30 pm 

5 – End of day:  5:00 pm 

C. Treat Email Inbox like you U.S. Mail Box – Keep it Empty!   I realize this is 
much easier to say than do.  However, if you have a good electronic filing system, 
it is do-able. 

D. Delete Whatever You Can Immediately:  Learn how to use the DELETE key.  
Shift+Delete permanently deletes the email (it’s not in your deleted mail folder).  
That could be the first thing that you do before you start dealing with email … 
just like not bringing junk mail and annoying advertising into your home.  Delete 
the following: 

i. All the email that gets past your SPAM filter. 

ii. Interoffice SPAM that is irrelevant to you. 

iii. Jokes from annoying friends and c-workers. 

iv. Email from people you don't like (unless it's important, of course) 
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TIP:  Sort email based on the From field (by hitting the From column header).  
You can often get rid of tons of email sent from the same person.  Remember 
that you can select a chunk of email by single left clicking on the first email – 
holding the Shift-key down and single left click on the last email. 

E. If You Can Deal With It In Under 3 Minutes, Do It Now:  The 3-minute rule is 
gold!  Any email that can be responded  to or dealt with (saved in a client file, 
forwarded, deleted, etc.) within 3 minutes should be dealt with immediately – the 
first time you lay eyes on it.  This rule is based on the premise that the 2nd time 
you have to deal with the email, it will take you longer than 3 minutes navigate to 
it, open it, read it, comprehend it, re-familiarize yourself with the topic and then 
handle it.  So, why not just respond to it if you have the 3 minutes to deal with it! 

TIP:  Don't forget that you may be able to deal with it more quickly by picking 
up the phone or walking around the corner.  

Remember, you are still supposed to be handling these emails only at 
scheduled/set times during the day!  This will be a difficult temptation to 
overcome – especially if you have email notification turned on and see an email 
that you can dispose of quickly. 

Finally, if it is an email that is going to take a while, you should dispose of it in 
under 3 minutes by adding it to your task list (or calendar) and then saving it 
into the appropriate client/matter file. 

F. Delegate If Appropriate - If someone else should be handling the task or issue in 
the email, then hand it off appropriately.  Don't let someone else put “the 
monkey” back on you, in the words of The One Minute Manager Meets the 
Monkey by Kenneth Blanchard.  Do this immediately unless it is going to take 
you more than 3 minutes to delegate.  You can make this easy to track by setting 
up the Delegated Email rule described in paragraph 3.C above (page 6). 

G. Delay If Necessary: If it is an email that is going to take awhile, you should 
simply dispose of it in under 3 minutes by adding it to your task list (or calendar) 
and then saving it into the appropriate client/matter file. 

i. Do not use Outlook as your to-do list by leaving unresolved email in your 
inbox. 

ii. If you keep a paper-based task list, simply write it in and save the email in 
appropriate place. 

iii. If you use Outlook to manage your task list, simply drag it over to your 
Task button in the Outlook navigator. 

iv. In some circumstances, it is okay to set up subfolders under your inbox.  
Clean them out on a weekly basis. 
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v. If you schedule your tasks as appointments, add it to you calendar. 

H. Use Texter To Handle Repetitive Responses:  You can respond to email faster 
by using Texter for repetitive sentences, entire responses, file numbers, 
signatures, etc.  Texter is a free program available at http://tinyurl.com/dak6ns. 

I. Fresh Start:  It’s never too late to try 43 Folder’s DMZ Technique - see 
http://tinyurl.com/yl5z6mh  

10. Your Inbox Is NOT a To-Do List: - Out of sight, out of mind.  As soon as that email 
that is supposed to remind you of something goes off the bottom of the screen, it may as 
well have never existed.  If you keep emails just for the information in the signature, 
maybe http://www.copy2contact.com/ is the right tool. 

11. Fix Outlook Default View Settings:  You need to see as many emails as possible on the 
screen. 

A. Turn Off Date Grouping: By default, Outlook groups your email by date 
received.  The date categories just occupy space and prevent you from seeing all 
of your email on one screen.  To turn it off, click the View menu � Arrange By � 
uncheck Show in Groups. 

B. Reading Pane:  If you use the reading pane, put it on the right and not at the 
bottom.  Click the View menu  Reading Pane  Bottom. 

C. Get a Tall Monitor:  Consider a monitor that rotates to portrait because you can 
see twice as much email on a “portrait” monitor as you can on a “landscape” 
monitor. 

 
 

http://www.copy2contact.com/�


  
The Inbox Ninjas: Helping You 
Chop Through Your E-Mail Inbox 
March 26, 2010 

 Page 18 of 24 

 

12. Convert Email to Tasks:  Just drag the email onto the Tasks button. 

 

13. Outlook Categories:  Outlook categories allow you to tag contacts, tasks and 
appointments with color and labels. 

A. Delete The Useless Categories Outlook Provides:  Outlook provides some 
useless categories that will just clutter up your list.  So the first step is to get rid of 

them.  Click the Categorize button on the Outlook toolbar ( )  click All 
Categories  click on each category you want to delete  click the Delete button. 

B. Example of Creating Categories for Clients:  Click the Categorize button on the 

Outlook toolbar ( )  click All Categories  click the New button, label the 
category "clients" and choose a color. 
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C. Assign Categories to Contacts:  There are multiple ways to do this.  One is to 
open a contact, click the Categorize button and assign one or more categories.  
You can also right-click a contact in the list, choose Categorize from the menu 
that appears, then choose the applicable category. 

D. View Contacts Assigned to a Particular Category:  Once set up properly, this is 
very easy.  Just follow these steps: 

i. Go to Contacts 

ii. Click the View menu  Current View  Define Views 

iii. Click the New button and give the "view" a name (Clients) and decide 
how you want the list presented (table, business card, etc.)  click the OK 
button. 
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iv. Now you're presented with the "Customize View" dialog.  Click the Filter 
button  More Choices tab  Categories button  choose the Clients 
category. 

v. Click OK  OK  Close. 

vi. Now you'll see Clients in your Current View pane on the left side of the 
contacts screen.  Just click on it and you'll instantly see just a list of 
contacts to which you've assigned the Clients category. 
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14. Fix Outlook's Fonts So They’re Uniform: In Outlook 2007, click the Tools menu  
Options  Mail Format tab  Stationery and Fonts.  Now make them all the same 
(they're not the same by default): 

15. Create Contacts from Email: Drag and drop an email to the Contacts button and 
Outlook will create a new contact card for that email sender. Another method is to use a 
third party program like Copy2Contact (see www.copy2contact.com).  This program 
allows you to select a name, address and phone numbers at the bottom of an email (for 
example), hit a hot-key, and instantly create a new contact in Outlook with all fields 
correctly populated.  It's free to try and $19.95 to buy.  They also make products for Palm 
and Blackberry smart phones. 
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16. To Encrypt or Not to Encrypt? According to most jurisdictions, a lawyer does not 
violate the duty to preserve confidences and secrets if an email is sent without encryption 
technology.  In light of evolving technology and rules, our recommendation is that 
attorneys (1) should advise clients verbally and in their engagement letter about email, 
and (2) should have encryption available for use in appropriate circumstances.  
Suggestions: 

A. Mail It Safe – www.mailitsafe.com  

B. PGP Desktop Email or Universal Gateway Email – www.pgp.com 

C. MessageGuard – www.networksolutions.com 

17. Quick Contact Search:  Just hit the F11 key and type in a first or last name. 

18. Saving Attachments to Email: 

A. One At A Time: Open the email, right click the attachment and choose Save As 
(also: drag and drop the attachment to the appropriate folder on your drive/ DMS 
software) 

B. In Bulk: 

i. Outlook 2007 – Office button  Save As  Save Attachments(also: drag 
and drop the attachment to the appropriate folder on your drive/ DMS 
software) 

ii. Outlook 2003 – File menu  Save Attachments  All Attachments (also: 
drag and drop the attachment to the appropriate folder on your drive/ DMS 
software) 

19. Set up your Signature Block:  Tools menu  Mail Format tab  “Signatures” button  
Click “New” 

20. Flags: Flags are a great way to alert you to follow up on an important email, especially if 
your plan is to delay action with the email for a day or so.  Simply right-click on the 
desired email and select Follow Up and then select the desired follow-up flag.   

21. Flags For Outgoing Mail:  Outgoing mail can also be sent with a reminder for your 
recipient: 
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Your email will appear in your recipient’s inbox with a flag.  Should your recipient click 
on this logo, the email will automatically be added to his task list: 

 

22. General Email Tips: 

A. Spelling and Grammar: Use proper spelling and grammar.  Emails that have 
proper spelling and grammar are more professional and easier to read.  It will also 
reduce the risk of misunderstanding, which is quite common with email 
communication.  In Outlook 2003, activate auto-spellchecker : Tools  Options 
 Spelling  Always check spelling before sending. 

B. Never Send an Angry Email: Never send an email if you are angry or frustrated.  
Wait 10 minutes, an hour, or even overnight if necessary. 

C. Use a Subject Line: Clearly describe the message contents in the Subject line.  A 
clear and concise description helps everyone organize their Inbox.  If reasonable, 
think of your subject line like an SMS summarizing your email.  
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D. Email Is Often Misinterpreted: There are many studies which indicate that 50% 
or higher of emails are misinterpreted regarding tone.  When appropriate, you 
should also consider using emoticons in order to clearly convey tone - ;) 

E. Beware of Forwarding Email: Be cautious of forwarding emails.  Read the 
entire email first.  There may be derogatory statements from others deep in the 
string. 

F. Be Cautious About Blind Copying: You can't trust the recipient to not hit 
REPLY TO ALL!  You are probably better off sending the original and then 
forwarding a copy to desired party. 

G. Avoid Large Attachments: Be cognizant of sending large attachments to people.  
Use services like Whalemail.com or Yousendit.com to send attachments to people 
who may have a file size limitation or slow internet connection. 

H. Only Copy People Who NEED To See It: Don't CC people or Reply to All 
unless it is absolutely necessary.  You know how many unnecessary emails you 
receive a day.  Don't be part of the problem – be part of the solution. 

I. Don’t Forward Junk: Don't forward jokes, spam or chain messages. 

J. No Caps: Don't type everything in CAPITALS.  In web-speak, this is equivalent 
to SHOUTING!  If someone does this to you, it probably means he/she thinks you 
are an idiot. 

K. Only Use Email When It’s Appropriate:  Examples:  

i. Informal email exchanges with friends could probably be moved to Instant 
Messaging to prevent this from overloading your inbox.  

ii. If you have a Blackberry Smartphone, when out of the office, use PIN or 
Blackberry Messenger for chatter, if you can't resist the temptation. 

iii. Collaboration tools such as white label social networks (or Google Wave) 
might be a better way of communicating. 

23. Spam Killers:  There are spam software applications, challenge-response systems, spam 
appliances and screening/filtering services.  We have tried many of these options and I 
have yet to find something easier and more powerful than Postini (www.postini.com). 


